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WHAT THIS HANDBOOK COVERS  

This note is intended for new engineers interested in modeling composites and experienced engineers who would like to 
get acquainted with the FEMAP interface.  

The following topics are covered: 

o A little background on the mechanics of composites and how micromechanics can be leveraged to obtain 
composite material properties 

o 2D composite laminate modeling 
 Defining a material model, layup, property card and material angles 
 Symmetric vs. unsymmetric laminate and why this is important  
 Results post processing 

o 3D composite laminate modeling 
 Defining a material model, layup, property card and ply/stack orientation 
 When is a 3D model preferred over a 2D model 

o Modeling a sandwich composite 
 Methods of modeling a sandwich composite 
 3D vs. 2D sandwich composite models and their pros and cons 

o Failure modeling of a 2D composite laminate   
 Defining a laminate failure model 

 Post processing laminate and lamina failure indices 

o Additional examples and theory   
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Composite Laminate Modeling Using FEMAP 
1. INTRODUCTION 

1.1 TERMINOLOGY 

 Composite material: A combination of two or more materials to form a new material system with enhanced 
material properties.  

 
    Examples of reinforcements are glass fibers, carbon fibers, silicon carbide fibers etc.  

 Examples of matrix materials are epoxy, polyurethane, silicon carbide etc. 

 

 Lamina: A lamina is a thin layer of composite material. The thickness of the lamina is usually 0.1 to 1 mm. It is also 
referred to as a ply. 
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 Laminate: A laminate is constructed by stacking a number of laminae. The building block for a laminate is lamina. 

 
1.2 TYPES OF MATERIALS 

In engineering applications, materials can be broadly classified as anisotropic, orthotropic, and isotropic. An anisotropic 
material has the generalized formulation, while other two are derived by some simplifications.  

 ANISOTROPIC MATERIAL   

An anisotropic material has no planes of material symmetry. Examples of anisotropic materials are femur, short-fiber 
composites etc. The number of constants required to describe anisotropic materials is 21. The stiffness matrix shown 
below is symmetric about the diagonal terms. Accordingly, all the diagonal terms and the terms above/below the 
diagonal terms have to be defined in the material model. 
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 ORTHOTROPIC MATERIAL 

An orthotropic material has three planes of material symmetry. Examples of orthotropic materials are wood, 
unidirectional lamina etc. The number of constants required to describe orthotropic materials is 9. The stiffness matrix is 
symmetric and all the diagonal terms and terms above/below the diagonal terms have to be defined. However, 
commercial finite element software allow defining the elastic moduli (E1, E2, E3), shear moduli (G12, G13, G23), and 
Poisson’s ratio (ν12, ν13, ν23) instead of calculating each of the stiffness terms. The finite element software can internally 
evaluate these stiffness terms.  

 
 ISOTROPIC MATERIAL 

All planes are planes of symmetry. Examples of isotropic materials are metals like steel, aluminum etc. There are only 
2 independent constants (C11 and C12) for an isotropic material. Similar to the orthotropic material model, one can define 
E and ν instead of calculating the stiffness terms. 
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2. COMPOSITE MICROMECHANICS 

 Study of composite material behavior wherein the interaction of constituent materials are examined on a 
microscopic scale to determine their effect on the properties of the composite material. 

 Predict the properties of composite, given the component properties and their geometric arrangement. 

 The mechanical properties of the composite depend on the percentages of fibers and matrix. 

2.1 RULE OF MIXTURES 

 If the fiber and matrix properties are available, a reasonable estimation of the lamina properties can be obtained 
using the rule of mixtures (strength of materials approach). 

 
Here, EL and ET correspond to longitudinal and transverse moduli of the composite lamina, GLT and νLT correspond to 
inplane shear modulus and Poisson’s ratio, respectively. Suffix ‘f’ corresponds to fiber property and ‘m’ corresponds 
to matrix property. In the above equations, ‘V’ corresponds to volume fraction. 

 APPLICATION EXAMPLE 

We will consider the mechanical properties of a carbon fiber and an epoxy resin to apply the rule of mixtures and 
estimate the lamina mechanical properties. For this example, we will consider a fiber volume fraction of 56%. For 
most structural applications, a fiber volume fraction greater than 55% is typically used. Increasing the fiber volume 
fraction can favor in terms of the load carrying capacity as fibers take majority of the load. However, fiber volume 
fraction cannot be increased beyond a certain limit (typically around 65%). Just as a note, the theoretical maximum 
volume fraction for a fiber (cylinder) is 78% for square packing. As the resin content is reduced, fibers are not 
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completely wet during the manufacturing process and can result in increased dry spots (part quality is reduced). This 
will result in reduced load transfer between the fibers.     

Constituent EL (GPa) ET (GPa) ν G (GPa) Vf(%) 

Carbon fiber 220 22 0.15 25 56 

Epoxy resin 3.3 3.3 0.37 1.2 - 

The carbon/epoxy lamina properties are calculated using the rule of mixtures as shown below. 

EL = 220*0.56 + 3.3*0.44 = 125 GPa 

1/ ET = (0.56/220) + (0.44/3.3) = 0.14 GPa -> ET = 7.4 GPa 

1/ GLT = (0.56/25) + (0.44/1.2) = 0.39 GPa -> GLT = 2.6 GPa 

νLT = 0.56*0.15 + 0.44*0.37 = 0.25 

The mechanical properties (2D orthotropic) obtained using the rule of mixtures for a carbon/epoxy lamina are shown 
below. 

Carbon/epoxy lamina EL (GPa) ET (GPa) GLT (GPa) νLT 

Rule of mixtures 125 7.4 2.6 0.25 

Chamis model 125 9.1 4.2 0.25 

Experimental [1] 125 9.1 5 0.34 
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3. LAMINATE MODELING IN FEMAP 
In this section, we provide details on modeling composite laminates in FEMAP. There are four important entities in which 
modeling laminates differs from conventional metallic components. Composite laminate modeling deals with the 
following modifications: 

 an orthotropic/anisotropic (typically) material configuration 
 laminates have a layered configuration, so a layup configuration has to be specified with the thickness of each 

layer and their orientation angles w.r.t a reference axis  
 an element/property type that accounts for the layered configuration has to be used 
 reference axis (material angle) specification 

Each of the above entities and their definition in FEMAP is summarized in the following sub-sections. There are two work 
flows that can be followed to model a laminate in FEMAP depending on whether the laminate model is a 2D or 3D. 
Defining the material cards, layup, and property cards is common between 2D and 3D models; however, material angles 
can be specified using two approaches in a 2D model while only one approach is used for a 3D model. In 2D models 
material angles can be specified at element level or directly in the property cards. Specifying material angles on elements 
is a convenient approach especially for complex geometries; we can select a set of elements and apply the material angle 
instead of assigning a specific material angle to all elements in a property card. For 3D models, we have to define 
material angles in the property card and so we need to create multiple property cards for complex geometries. In the 
following sub-sections, an overview of FEMAP interface for laminate modeling is provided accompanied by worked 
examples.       

Work flow 1 Work flow 2 
laminate (2D) laminate (2D) and solid laminate (3D) 

material model material model 
layup layup 

property card property card with material angle 
define material angle on element  
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3.1 IMPORTANT ENTITIES 

Modeling composites can be easier if the following entities are carefully assigned. 
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3.2 DEFINING AN ORTHOTROPIC MATERIAL 

• Notice that we have different properties in longitudinal (E1) and transverse (E2) directions, where E1 is aligned to 
the angle specified within the layup. 

• Depending on the type of analysis, various material properties are required.  
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3.3 UNDERSTANDING THE LAYUP EDITOR 
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3.4 PROPERTY CARD: 2D LAMINATE MODELING 
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3.5 ASSIGNING MATERIAL ANGLES  

Although, orientation angles are specified for each lamina individually in the layup editor, FEMAP will not understand as 
to which reference direction these orientations (angles) correspond. So, we need to specify a material angle such that all 
orientations (specified in layup) take this vector as the reference. For example, if the material angle is defined in the 
global x-direction then all the orientations will use global x-direction as the reference. One should not be confused with 
the terminologies ‘material angle’ and ‘orientation angle’ in the layup editor. Material angle is a reference axis that we 
assign to the element and is independent of the shape of the element. Orientation angle is the orientation of the lamina 
(fiber direction). By default, FEMAP assigns no material angle. Use any of the following methods to specify the material 
angle.   

 
Image source: https://www.faa.gov/regulations_policies/handbooks_manuals/aircraft/amt_airframe_handbook/media/ama_Ch07.pdf 
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 DEFINING A MATERIAL ANGLE ON THE ELEMENT 

One can define/update the material angles using toolbar Modify -> Update Elements - > Material Orientation. 

 
This method allows one to define a material angle to a selected set of elements or all the elements at a time. It is 
important to note that the material angle is independent of the element coordinate system and the element shape. For 
example, the image below shows elements that are distorted. However, the material angles are all aligned to the global-x 
direction. If a material angle is not defined, FEMAP will show an error message. If you miss defining a material angle for a 
few elements in the model, it can be quite difficult to trace the elements with missing definitions. We have developed an 
API to filter these elements with missing elements and group them. By accessing this newly created group, one can 
assign/update the material angles to these elements only. The API is called Composites Material Angle Checker, and can 
be downloaded from our website at http://www.appliedcax.com/support-and-training/apis/apis.html. One can verify the 
material angles in the laminate elements by selecting the following options under F6 or View Options.    
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 DEFINING A MATERIAL ANGLE IN THE PROPERTY CARD 

In this approach, we can define a material angle directly in the property card. However, this will assign the material angle 
to all the elements that the property id is associated with.  One can also check the assigned material angles and update 
them (in case of any incorrect material angles) accordingly using the procedure in approach 1.    
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In case of a complex geometry with curved surfaces, material angles can be effectively defined using the cylindrical 
coordinate system by using the tangent direction if the vector has to follow a curved surface. Always remember to verify 
your material angles! 

 ADVANCED APPLICATION EXAMPLE OF ASSIGNING MATERIAL ANGLE TO A COMPLEX GEOMETRY 

The example below shows a composite wing leading edge. The 0° material angle needs to follow the curvature of the 
leading edge. However, we can see from the picture that the vectors (representative of the material angles) do not 
follow the curvature.   
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In order to assign the material angle accurately, we can use the cylindrical coordinate system (R, T, Z) instead of a 
rectangular coordinate system (X, Y, Z). We want to create a new cylindrical coordinate system (instead of an existing 
cylindrical coordinate system) that will do a better job in accurately assigning the material angles. Follow the steps below 
to create a new cylindrical coordinate system. 

Vectors do not follow the 
curvature of the leading edge  
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The new coordinate system is shown below.  
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We will use the procedure detailed in section 3.5.1 (Defining a material angle on the element) to update the material 
angle. Go to toolbar Modify -> Update Elements - > Material Orientation. 

This will prompt you to select the elements for which the material angle has to defined/updated. For this example, we 
will select all the laminate plate elements. Next, you will be prompted to select the material orientation direction (shown 
below). 

 
The above procedure will orient the all the material angles along the curvature of the leading edge. 
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3.6 PROPERTY CARD: 3D LAMINATE MODELING 

 
In 3D laminate modeling, we define a ply/stack direction instead of a material angle. For example, if the material angle is 
in global-x and the layup stacking in global-z, then we specify the ply/stack direction as XZ (13). Unlike 2D, we cannot use 
approach 1 (Modify -> Update Elements - > Material Orientation) for 3D solid laminate elements. We can create multiple 
property cards (if necessary) with different ply/stack directions for sections of your geometry. And try to explore other 
coordinate systems for specifying the ply/stack direction. 
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3.7 MULTI-MATERIAL ANGLE EXAMPLE OF A 3D COMPOSITE MODEL 

This example shows a composite component with sections oriented in different directions. The component is modeled 
using laminate solid elements. Here, we cannot use a single ply/stack direction for all the sections of the component.  
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In this example, we will create three property cards (identified by color as shown above) to define ply/stack direction 
separately for each of the three sections of the composite component. The following images will show how ply/stack 
directions have been defined for these sections.  
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4. EXAMPLE 1: CREATING A 2D LAMINATE MODEL IN FEMAP 

4.1 INTRODUCTION 

In this example, we will analyze a simple composite laminate with a hole subjected to uniaxial tension. Composite 
laminates are often studied for open-hole tension in the aerospace industry. The material, layup, and the thicknesses 
used in this example are from a real world composite part. Here, we will study two types of layups with the same number 
of layers and same orientations but stacked in different ways. We will analyze the differences in the results just by 
altering the layup stacking order. We will learn this unique behavior of composites by working out this example. With 
multiple plies in the layup, this is also a good example for post processing.    

4.2 CREATING THE MATERIAL PROPERTY 

The material properties used for the laminate correspond to a unidirectional carbon/epoxy lamina. Accordingly, the 
material type needs to be ‘2D Orthotropic’ for this problem. The material properties are shown in Table 1. 

Table 1: Mechanical properties of a unidirectional T800S/3900-2 lamina 

Property Unit T800S/3900-2 

Longitudinal elastic modulus (E1) GPa 147 

Transverse elastic moduli (E2 = E3) GPa 7.58 

In-plane shear modulus (G12) = Interlaminar shear modulus (G13) GPa 3.96 

Interlaminar shear modulus (G23) GPa 3.00 

In-plane Poisson’s ratio (ν12) = Interlaminar Poisson’s ratio (ν13)  0.33 

Interlaminar Poisson’s ratio (v23)  0.38 

Longitudinal tensile strength (Xt) = Longitudinal compressive strength (Xc) GPa 2.86 

Transverse tensile strength (Yt) = Transverse compressive strength (Yc) GPa 1.55 

Shear strength (S) GPa 0.104 
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Since the laminate model is 2D, the direction 3 properties can be ignored for this problem. 

 
 

4.3 DEFINING THE LAYUP 

We will analyze two types of layups in this model. The idea is to observe how the layup can affect your analysis even if 
the laminate effectively has the same number of layers, same orientation angles, but stacked up in a different sequence. 

Layup 1: [45°/90°/-45°/0°]s with each layer at 0.195 mm thickness. The subscript ‘s’ in the layup definition shows that it is 
symmetric laminate. This implies that the layup configuration is [45°/90°/-45°/0°/0°/-45°/90°/45°]. 
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Layup 2: [45°/90°/-45°/0°/45°/90°/-45°/0°]. Layup 2 has 8 layers as layup 1 except that the layup configuration is no 
longer symmetric about laminate’s mid-plane.  

The layup editor with Layup 1 defined is shown below. Layup 2 can be defined in a similar manner by changing the 
orientation angles. 

 
4.4 DEFINING THE LAMINATE PROPERTY (PCOMP) 

The Nastran property card for 2D laminates is PCOMP. Detailed information on the PCOMP card is available in the 
Nastran User Guide. The 2D laminate formulation is based on classical lamination theory. Select the ‘Laminate’ 
element/property type in the property card. By default, FEMAP assigns ‘plate’ element type for 2D models. The layup 
defined in the previous step can be assigned in the property card. Since we have defined all the 8 layers in the layup, 
‘options’ is left to its default ‘As Specified’ in the property card. Alternatively, we can define 4 layers only in the layup and 
use ‘Symmetric’ option. However, this option has to be used with caution as it cannot be used for unsymmetric 
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laminates. Ideally, one can define all the layers in the layup editor unless there are a large number of layers (e.g., thick 
composite).     

 
4.5 SPECIFYING MATERIAL ANGLES 

For this problem, we will use global x-direction as our material angle. We can use one of the procedures which were 
introduced earlier. 

4.6 ANALYSIS SETUP AND POST PROCESSING 

For this model, a force of 10 kN is applied on the nodes on one end and fixed constraints are applied on the other end as 
shown below. To simulate the experimental loading behavior, the 10 kN load is applied on an independent node and this 
node is rigidly linked to nodes on the right end of the laminate model (shown below). When the load is applied on the 
independent node, the resulting displacement is translated to the dependent nodes.      
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The model is ready to be analyzed and is solved for a linear static case. The model is analyzed for the two layups and the 
deformations observed in both these cases are discussed. 
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 ANALYSIS SET MANAGER SETUP FOR COMPOSITES 

 SRCOMPS controls the computation and printout of ply strength ratios. When ‘on’, ply strength ratios are output for 
composite elements that have failure indices requested. 

 NOFISR controls the printout of the composite failure indices and strength ratios. When ‘on’, the failure indices and 
strength ratios will not be printed. 
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 POST PROCESSING THE RESULTS 

Initially, the model with the symmetric laminate ([45°/90°/-45°/0°/0°/-45°/90°/45°]) was analyzed. The total translation 
in this model is shown below. The deformations are symmetric about the x-axis. Under the applied uniaxial tensile load, 
deformations were inplane as expected. No out-of-plane deformations were observed.  

Next, the model with unsymmetric laminate ([45°/90°/-45°/0°/45°/90°/-45°/0°]) was analyzed. From the contours (shown 
below), it can be observed that the deformations were not symmetric about the x-axis. Also, we can now see that the 
unsymmetric laminate resulted in an out-of-plane deformation although the loading was uniaxial.  

 

Symmetric laminate – No 
out-of-plane deformations 
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This kind of behavior is unique in fiber-reinforced composite laminates and often not explored due to inherent design 
challenges. An unsymmetric layup can result in warping of the laminate as early as during the manufacturing process 
when the laminate is cured at high temperatures. Thus, it is quite challenging to design an unsymmetric laminate to suit a 
specific loading environment. One practical example of an unsymmetric laminate application is in the forward swept 
composite wings of the X-29 aircraft [2].     

Unsymmetric laminate with 
out-of-plane deformations 
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Photo courtesy of Structural Mechanics Corporation 
http://structuralmechanics.com/about/resources/newsletter/articles/you-pull-it-twists-tailored-composites/ 

If this subject interests you, please see the Appendix. Next, we proceed to stress distributions in the individual plies. For 
this discussion, we will use the symmetric laminate results.  

X-29 aircraft 



 

 

Predictive Engineering White Paper 

 
2020 

Predictive Engineering Document, Feel Free to Share With Your Colleagues Page 38 of 107 

 
The stress contour shown above corresponds to the major principal stress in ply 4 (0° layer). Similarly, we can plot stress 
distribution in other layers. FEMAP has bunch of output options and sometimes it can be difficult to find the same output 
vector for another ply. There are some custom tools available in FEMAP which can be effectively used for laminates. For 
example, we can use the ‘Laminate Prev Ply’ tool to plot ply 3 Major Principal Stress (provided we have a plot of ply 4 
Major Principal Stress) without putting effort in finding the output vector amongst large set of results. This will be 
particularly useful if you have a large number of layers in the laminate. Some of the tools which are specific to laminates 
are shown below. These tools can be accessed from Custom Tools -> PostProcessing. 
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If you would like to use these API’s frequently, we can create a customized toolbar with these commands. It is easier this 
way to find a command in the toolbar rather than searching for these commands in the Custom Tools. We have created a 
video on creating a customized toolbar and can be accessed from https://www.youtube.com/watch?v=RT_7uIor6Ww 

5. EXAMPLE 2: CREATING A 3D LAMINATE MODEL IN FEMAP 

5.1 INTRODUCTION 

In this example, we will develop a 3D laminate model to analyze a simple composite laminate with a hole subjected to 
uniaxial tension. This is an extension of example 1 to a 3D laminate model. The goal is to understand the applicability of 
both the models. The material, layup, thicknesses, and the approach used in this example are same as in the example 1. 
A major difference between the 2D laminate model and the 3D laminate model is that the former will not take out-of-
plane stresses in to account while the latter will. The 3D laminate models will be useful if you are modeling a composite 
structure with free edges like holes where the out-of-plane shear stresses can be important.  
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5.2 CREATING THE MATERIAL PROPERTY 

Defining the material properties for a 3D laminate model is similar to the 2D model except that the material type is now 
3D orthotropic. Accordingly, direction-3 properties should also be defined. All the required properties are defined in 
Table 1.   

5.3 DEFINING THE LAYUP 

Specifying the layup configuration is similar to the 2D case. However, the material property (3D orthotropic) created in 
the previous step has to be used instead of 2D orthotropic properties as in example 1. 

5.4 DEFINING THE LAMINATE PROPERTY (PCOMPS) 
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The Nastran property card for 3D laminates is PCOMPS. Detailed information on the PCOMPS card is available in the 
Nastran User Guide. Select the ‘Solid Laminate’ element/property type in the property card. By default, FEMAP assigns 
‘Solid’ element type for 3D models. The layup defined in the previous step can be assigned in the property card. The 
interface for the 3D laminate property card is slightly different from the 2D case. Here ‘Ply/Stack Direction’ has to be 
assigned. For example, for the 3D laminate model the Ply/Stack Direction is specified as ‘XZ (13)’. Here, ‘X’ corresponds to 
the direction of the material angle (as defined in 2D case) and ‘Z’ corresponds to the stacking direction. Unlike the 2D 
laminates, the 3D laminate formulation is not based on classical lamination theory. 

5.5 SPECIFYING MATERIAL ANGLES 

The only difference between specifying material angles for a 2D case and 3D case is that the 3D model requires specifying 
the ‘Ply/Stack Direction’. The overall concept is still the same.  

5.6 POST PROCESSING THE RESULTS 

The image below shows the finite element mesh of the 3D laminate model. In this example, only one solid element is 
defined through the thickness. The thickness of the element corresponds to the total thickness of the laminate – 1.56 
mm.  

 

1.56 mm 

Front view Top view 



 

 

Predictive Engineering White Paper 

 
2020 

Predictive Engineering Document, Feel Free to Share With Your Colleagues Page 42 of 107 

The 3D laminate model is analyzed with the symmetric layup configuration. The observed displacements and stresses are 
shown below. The displacement results are quite similar to the 2D case.  

 
The major principal stress distribution in ply 4 (0° layer) is shown below. 
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6. EXAMPLE 3: MODELING A SANDWICH COMPOSITE  

6.1 INTRODUCTION 

In this example, a 3D sandwich composite model is analyzed for a uniform pressure loading. The sandwich composites 
have a core (e.g., honeycomb, foam, etc.) sandwiched between two facesheets. Typically, the facesheets carry the 
majority of the inplane and bending loads while the core takes shear. A sandwich composite can be conveniently 
modeled using the 2D laminate layup by defining the core as one of the layers in the layup editor (shown at the end of 
this example). While this procedure is easy, interlaminar shear stresses (around free edges) become important in 
sandwich composites and 2D laminate models (based on classical lamination theory) do not account for the out-of-plane 
stresses.  

6.2 CREATING THE MATERIAL PROPERTY 

Two material models, each for the composite facesheet and core are defined. The composite facesheet is modeled as a 
3D orthotropic material and the properties are shown in Table 1 (example 1). The core is modeled as an isotropic 
material with E = 4 GPa and ν = 0.25 [3]. 

6.3 DEFINING THE LAYUP 

Defining the laminate layup for the facesheets is same as in example 2. However, it should be noted that we have two 
facesheets and so we have to create two solid laminate property cards, one for the top facesheet and one for the bottom 
facesheet. If two layups are not created separately for each of the facesheets, we will see output vectors corresponding 
to 8 plies only in the results set. If two layups are created, then we can see output vectors for 16 plies, 8 for the bottom 
facesheet and 8 for the top facesheet.  

6.4 DEFINING THE PROPERTY CARDS 

Three property cards have to be created, two of solid laminate type for facesheets and one solid type for the core. Each 
of the solid laminate property cards have to be assigned to the corresponding facesheets. The material angles 
specification for the solid laminates is similar to the previous example. 
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6.5 POST PROCESSING THE RESULTS 

Clamped boundary conditions have been applied on the sandwich composite edges and a pressure load of 1 MPa is 
applied on the top surface. 

 
 

 

Top view Front view 
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The deformation plot of the sandwich composite due to the applied pressure load is shown below.  

 
The interlaminar shear stress distribution in the core is shown below. One can mask the facesheet elements while 
plotting the shear stress distribution in the core.  
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The bond between the core and facesheets is one of the critical regions for delamination in sandwich composites. These 
interlaminar shear stresses are higher at the free edges and these areas are potential regions for delamination initiation. 
One can compare the interlaminar shear stresses to the core-to-facesheet bond shear allowable and analyze for any 
possible delaminations. 

6.6 OTHER METHODS FOR SANDWICH COMPOSITE MODELING 

In this example we have developed a 3D sandwich composite model in which the facesheets and the core are modeled as 
solids. Other methods by which the above problem can be analyzed are: 

1. 2D sandwich composite modeling in which the facesheets and the core are all 2D and can be defined in a single 
layup definition. This is a convenient approach however, as discussed earlier, the 2D laminate models are based on 
classical lamination theory and do not account for the out-of-plane stresses. Secondary methods are used to 
estimate the interlaminar stresses. 

 
2. A mix of 2D laminates and 3D core. In this method, the facesheets can be modeled as 2D and the core can be 

modeled as a solid. One should be careful about defining the laminates for this configuration. Both the facesheets 
have to be placed at an offset of half the laminate thickness from the solid core.  
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3. Using the classical plate theory to model sandwich composites. This model requires some hand calculation to be 
done and is complex as compared to the 2D laminate model. The Nastran property card corresponding to the plate 
model is the PSHELL card. In the method 1 described above, Nastran converts a PCOMP property into an 
equivalent PSHELL. So, both method 1 and method 2 should give similar results if all the properties are accurately 
defined. To avoid confusion, method 1 is preferred over method 2 as both are the same in terms of how Nastran 
interprets the property card. Alternatively, FEMAP has a custom tool to define a sandwich composite using the 
PSHELL method. One can do hand calculations and compare their values with the FEMAP calculated value as 
shown below. This custom tool for sandwich composites can be accessed from Custom tools -> Honeycomb PSHELL 
-> Honeycomb PSHELL Property. 
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7. LAMINATE FAILURE THEORIES IN FEMAP 

7.1 INTRODUCTION 

The behavior of composites is complex (as a result of heterogeneous properties) when compared to monolithic 
materials. Understanding the behavior of composites under extreme conditions of mechanical loading, temperature, and 
other environmental factors poses a great challenge. The effect of these service conditions on the composite can range 
from a minor loss of stiffness at micro-level to catastrophic failures at structural level. The microstructure of the 
composite evolves in multiple ways before evidencing measurable degradation. Typical forms of micromechanical 
failures include fiber breaking, matrix cracking, fiber/matrix interface debonding etc. Factors such as microcracking 
(typically in a matrix) are unavoidable and can be inherent in the manufactured composite part. Microcracking can result 
from processing the composites at high temperatures (cure cycle), due to differences of thermal 
conductivities/coefficients of thermal expansion between the constituents (fiber, matrix). Other forms of composite 
material property degradation can result from hygrothermal loading and oxidation. 

In this section, we will deal with the failure at ply level and not the micromechanical failures. Several failure theories have 
been developed to study failure envelopes of composite laminates. The failure theories that are available in FEMAP are 
discussed below. Some of these models (maximum stress theory, maximum strain theory) are based on pure comparison 
of observed stresses/strains in the laminate with their respective allowables. Other models such as Hill’s theory, Tsai-Wu 
theory, and Hoffman’s theory consider interaction of longitudinal/transverse stresses/strains to predict the failure 
envelope. Although failure theories can be handy to check the failure indices and decide if failure occurs in the laminate, 
it is important to understand the stress distribution in the model, interlaminar stresses and their effects on delamination, 
ABD matrices etc.    

7.2 HILL’S THEORY 

• Hill’s failure theory is applicable for orthotropic materials that have the same strength in tension and compression, 
i.e., Xt = Xc and Yt = Yc. Failure Index (FI) is given by: 
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X is allowable stress in 1-direction 
Y is allowable stress in 2-direction 
S is allowable stress in shear 
Xt = Allowable tensile stress in 1-direction 
Xc = Allowable compressive stress in 1-direction 
Yt = Allowable tensile stress in 2-direction 
Yc = Allowable compressive stress in 2-direction 
 
X = Xt if σ1 is positive or X = Xc if σ1 is negative and similarly for Y and σ2. For the interaction term σ1σ2/X2, X = Xt if σ1 
is positive or X = Xc if σ1 is negative. 
 

 Strength Ratio (SR) is given by,  

 
7.3 HOFFMAN’S THEORY 

• Hoffman’s theory for an orthotropic lamina in a general state of plane stress with unequal tensile and compressive 
strengths is given by, 

 

 
• The failure index is obtained by evaluating the left-hand side of the above equation. 
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7.4 TSAI-WU THEORY 

• The theory of strength for anisotropic materials proposed by Tsai and Wu specialized to the case of an orthotropic 
lamina in a general state of plane stress with unequal tensile and compressive strengths is, 

 

 
• The failure index is obtained by evaluating the left-hand side of the above equation. 

• F12 is to be evaluated experimentally. By default, this term is set to zero in FEMAP (Tsai-Wu interaction term). 

7.5 MAXIMUM STRAIN THEORY 
• The maximum strain criterion has no strain interaction terms. The failure index is calculated using, 

 
• X, Y, and S are allowable strains in longitudinal direction, transverse direction and inplane, respectively. 
• A failure index for maximum stress theory (available for 3D laminate modeling) can be derived similar to maximum 

strain theory. 
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7.6 ONSET FAILURE THEORY 

The Onset failure theory or the Strain Invariant Failure Theory (SIFT) is widely used in the aerospace industry. A brief 
overview of this failure criterion is provided in the appendix.  

8. EXAMPLE 4: MODELING THE FAILURE BEHAVIOR OF COMPOSITE LAMINATES 

For this example, we will use the 2D laminate model from example 1. All the modeling procedure that we have done for 
the 2D laminate model will be supplemented by defining failure strengths of the lamina and a failure criterion. The goal is 
to study the failure in composite laminates and also explore the output vectors that can be handy in visualizing the 
failure at ply level and laminate level.  

8.1 CREATING THE MATERIAL PROPERTY 
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8.2 DEFINING THE LAMINATE PROPERTY 

The laminate layup is the same as in example 1. The laminate property card is also defined in a similar manner. 
Additionally, we specify a failure criterion to calculate the failure indices at ply level and for the whole laminate. For this 
example, we will use the Hoffman’s failure criterion. The bond shear allowable term is defined to predict interlaminar 
bond failure. If one is not interested in the interlaminar failure, this term can be left to its default value 0.  

 
The specification of material angles follows the same approach as in example 1. 

8.3 RESULTS 

In this example, we are mainly interested at looking into the failure indices and evaluate the laminate and individual 
lamina. A uniaxial tensile load of 50 kN is applied. The contour below shows the laminate failure index and can be 
accessed from the output vector – 6060…Laminate Max Failure Index. This output vector shows the overall failure index 
of the laminate. A contour value (failure index) greater than or equal to 1 implies failure. Based on this information, one 
can assume that there are one or more layers in which the failure has occurred.   
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Next, we can check the failure index output vector on a ply-by-ply basis to find out the layers in which the failure has 
occurred. We can contour the output vector ‘Lam Ply Fib Fail Index’ for a particular ply and then use the custom tool 
options ‘Laminate Next Ply’ or ‘Laminate Prev Ply’ and check the failure indices.  

Within Custom Tools -> PostProcessing, FEMAP has an API for ‘Laminate Envelope Failure Indices’. Currently, this API 
generates the same output vector as ‘6060…Laminate Max Failure Index’. However, this API can be custom modified to 
envelop other output vectors (e.g., bond failure indices). 

Instead, if you are interested in manually selecting the output vectors and enveloping them to a single output vector, you 
can use Model -> Output -> Process 
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An example of enveloping major principal stresses in all the plies is shown below. This procedure can be followed to 
envelope any output vector. 

If the analysis has only one output set, then we can envelope the output vectors from that output set. However, if we 
have multiple output sets, then we need to select one or more output sets from which we would like to envelope the 
output vectors.  
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This will create new output vectors as shown below. 
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Other output vectors are also created which allow finding the location info (ply and element) of the maximum major 
principal stress. For example, from the above contour, we can see the location of the element with the maximum major 
principal stress. However, we do not know the respective ply that has this maximum value. The newly created output 
vector – ‘Envelope Location Info’ will have this information. One can modify the contour/criteria style to display only the 
max value, min value or both. Because, we are interested in max value only, required changes were done using F6 (View 
Options) -> PostProcessing -> Contour/Criteria Style -> Max Only. From the contour below, we can see that the maximum 
value of major principal stress is observed in ply 4. 

 
9. ADDITIONAL READING 

 Chapter 24: Laminates, NX Nastran User’s Guide 
 ‘PCOMP and PCOMPS’ in NX Nastran Quick Reference Guide 
 Chapter 6: Element Reference – ‘Laminate Element and Solid Laminate Element’ in FEMAP User Guide 
 I. M. Daniel and O. Ishai, “Engineering Mechanics of Composite Materials,” 2nd Edition, 2005. 
 R. M. Jones, “Mechanics of Composite Materials,” 2nd Edition, 1998. 
 B. D. Agarwal, L. J. Broutman, and K. Chandrashekhara, “Analysis and Performance of Fiber Composites,” 3rd Edition, 

2006. 
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10. MATERIAL DATABASE  
This section provides material properties of some commonly used fibers (Table 2), polymer resins ( 

  



 

 

Predictive Engineering White Paper 

 
2020 

Predictive Engineering Document, Feel Free to Share With Your Colleagues Page 59 of 107 

Table 3), and fiber-reinforced polymer composite materials (Table 4). Typically fibers are assumed to be isotropic. 
However, some references also considered transversely isotropic properties (different properties in longitudinal and 
transverse directions) for carbon fibers. Matrix materials are typically isotropic in nature.  

Table 2: Mechanical properties of commonly used fibers [4] 

Fiber Tensile Modulus (GPa) Tensile Strength (MPa) Density (kg/m3) 

E-Glass 72.5  3500 2630 

S-Glass 88  4600 2490 

AS4 Carbon 245  4000 1800 

IM7 Carbon 317 4900 1744 

Kevlar 29 64 2860 1440 

Kevlar 49 124 3650 1440 

Boron 400 3620 2574 
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Table 3: Mechanical properties of commonly used polymer resins [5] 

Resin Tensile Modulus (GPa) Tensile Strength (MPa) Density (kg/m3) 

Epoxy 3.5  45 1200 

Polycarbonate 2.7 77 1200 

Polyethylene 0.7 33 950 

Polyurethane 0.025 30 1200 

Polyvinyl Chloride 1.5 60 1400 

Table 4: Mechanical properties of commonly used fiber-reinforced polymer composite materials 
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11. FOUR-POINT BENDING OF A SANDWICH COMPOSITE USING FEMAP AND NX NASTRAN 

In this section, the simulation of four-point bending test (ASTM Standard D7249) of a sandwich composite is presented. A 
detailed hand calculation is presented to obtain the ply level stresses and strains. The simulation results are also 
compared with experimental data and hand calculation. 

The geometry and loading configuration of the four-point bend specimen are shown below. Table 5 provides the applied 
load and the specimen geometry used in the four-point bend test.   

 
Table 5: Geometry and loading configuration of the four-point bend specimen 

Parameter Symbol Value 
Load P 900.9 lbf 

Support Span S 22 in. 
Load Span  L 4 in. 

Beam Width b 3 in. 
Beam Thickness t 1 in. 

Facesheet Thickness tf 0.02 in. 
Core Thickness tc 0.96 in. 

Individual Ply Thickness tply 0.005 in. 

P/2 P/2
(S-L)/2 (S-L)/2L

S

0/90/0/90/Core/90/0/90/0

b

t
tf

tf

tc

Carbon/epoxy 
facesheet

Honeycomb 
core
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11.1  HAND CALCULATION 

We will first show the hand calculations for a basic laminate which will provide a good foundation for sandwich 
composites. For sandwich composites, the concept and the equations are similar except that we have to account for 
facesheet offset from the midplane due to the core thickness. 

 BASIC LAMINATE 

Consider an eight ply composite laminate with [0/90/0/90]s layup configuration (𝑛 = 8). We have an individual ply 
thickness 𝑡௣௟௬ = 0.005 in. We will use xyz-axis notation for material axis (ply level, local axis) and 123-axis for laminate 
axis (global axis). This convention is consistent with the notation used in the textbook, “Introduction to Composite 
Materials,” by Stephen W. Tsai and H. Thomas Hahn. This textbook was referred for the theory on flexural loading of 
composite laminates and sandwich composites.  
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We can calculate the stiffness terms 𝑄௜௝ for each ply by using the following transformation. 

 𝑄௫௫ 𝑄௬௬ 𝑄௫௬ 𝑄௦௦ 

𝑄ଵଵ 𝑚ସ 𝑛ସ 2𝑚ଶ𝑛ଶ 4𝑚ଶ𝑛ଶ 

𝑄ଶଶ 𝑛ସ 𝑚ସ 2𝑚ଶ𝑛ଶ 4𝑚ଶ𝑛ଶ 

𝑄ଵଶ 𝑚ଶ𝑛ଶ 𝑚ଶ𝑛ଶ 𝑚ସ + 𝑛ସ −4𝑚ଶ𝑛ଶ 

𝑄଺଺ 𝑚ଶ𝑛ଶ 𝑚ଶ𝑛ଶ −2𝑚ଶ𝑛ଶ (𝑚ଶ − 𝑛ଶ)ଶ 

𝑄ଵ଺ 𝑚ଷ𝑛 −𝑚𝑛ଷ 𝑚𝑛ଷ−𝑚ଷ𝑛 2(𝑚𝑛ଷ−𝑚ଷ𝑛) 

𝑄ଶ଺ 𝑚𝑛ଷ −𝑚ଷ𝑛 𝑚ଷ𝑛 − 𝑚𝑛ଷ 2(𝑚ଷ𝑛 − 𝑚𝑛ଷ) 

𝑚 = cos 𝜃, 𝑛 = sin 𝜃 

To better understand the stiffness terms in material coordinate system, the following relations are provided. Here, 𝜎௦ 
corresponds to the inplane shear stress - 𝜎௫௬.  

 𝜀௫ 𝜀௬ 𝜀௦ 

𝜎௫ 𝑄௫௫ 𝑄௫௬  

𝜎௬ 𝑄௫௬ 𝑄௬௬  

𝜎௦   𝑄௦௦ 
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The above relations are provided in terms of the compliance matrix as shown below (𝑄௜௝ = 𝑆௜௝
ିଵ). 

 𝜎௫ 𝜎௬ 𝜎௦ 

𝜀௫ 𝑆௫௫ 𝑆௫௬  

𝜀௬ 𝑆௫௬ 𝑆௬௬  

𝜀௦   𝑆௦௦ 

 

It is easier to calculate the compliance matrix (𝑆௜௝) rather than the stiffness matrix (𝑄௜௝). The compliance matrix terms can 
be calculated from the elastic properties of a unidirectional lamina (𝐸௫ = 20.6 𝑀𝑠𝑖, 𝐸௬ = 1.3 𝑀𝑠𝑖, 𝐸௦ = 𝐺௫௬ =

0.55 𝑀𝑠𝑖, 𝜈௫௬ = 0.326) as shown below. 

𝑆௫௫ =
1

𝐸௫
=

1

20.6 × 10଺
= 4.85 × 10ି଼ (𝑝𝑠𝑖)ିଵ 

𝑆௬௬ =
1

𝐸௬
=

1

1.3 × 10଺
= 7.69 × 10ି଻ (𝑝𝑠𝑖)ିଵ 

𝑆௫௬ =
−𝜈௫௬

𝐸௫
=

−0.326

20.6 × 10଺
= −1.58 × 10ି଼ (𝑝𝑠𝑖)ିଵ 

𝑆௦௦ =
1

𝐸௦
=

1

0.55 × 10଺
= 1.82 × 10ି଺ (𝑝𝑠𝑖)ିଵ 

Now, the stiffness matrix can be easily calculated by inverting the compliance matrix.  

቎

𝑄௫௫ 𝑄௫௬ 0

𝑄௫௬ 𝑄௬௬ 0

0 0 𝑄௦௦

቏ = ቎

𝑆௫௫ 𝑆௫௬ 0

𝑆௫௬ 𝑆௬௬ 0

0 0 𝑆௦௦

቏

ିଵ
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We get, 

𝑄௫௫ = 20.7 × 10଺ 𝑝𝑠𝑖 

𝑄௬௬ = 1.31 × 10଺ 𝑝𝑠𝑖 

𝑄௫௬ = 4.27 × 10ହ 𝑝𝑠𝑖 

𝑄௦௦ = 5.50 × 10ହ 𝑝𝑠𝑖 

Using the off-axis transformation relations (provided earlier), we can calculate the stiffness terms 𝑄௜௝ i, j = 1, 2, 6. 

Stiffness term 𝜃 = 0 𝜃 = 90 

𝑄ଵଵ 20.7 × 10଺ 𝑝𝑠𝑖 1.31 × 10଺ 𝑝𝑠𝑖 

𝑄ଶଶ 1.31 × 10଺ 𝑝𝑠𝑖 20.7 × 10଺ 𝑝𝑠𝑖 

𝑄ଵଶ 4.27 × 10ହ 𝑝𝑠𝑖 4.27 × 10ହ 𝑝𝑠𝑖 

𝑄଺଺ 5.50 × 10ହ 𝑝𝑠𝑖 5.50 × 10ହ 𝑝𝑠𝑖 

𝑄ଵ଺ 0 0 

𝑄ଶ଺ 0 0 

When a composite laminate is subjected to flexural loading, the moment-curvature relations are of interest rather than 
force-strain relations (inplane loading case). The moments and curvatures are related by an equivalent bending stiffness 
matrix for a multidirectional composite laminate. We can calculate the bending stiffness matrix 𝐷௜௝ i, j = 1, 2, 6. From the 
equation we can infer that 𝐷௜௝ is dependent on the stacking sequence.  

𝐷௜௝ =
2

3
𝑡௣௟௬

ଷ ෍ 𝑄௜௝
௞[𝑘ଷ − (𝑘 − 1)ଷ]

௡
ଶൗ

௞ୀଵ
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We get, 

൥

𝐷ଵଵ 𝐷ଵଶ 0
𝐷ଵଶ 𝐷ଶଶ 0

0 0 𝐷଺଺

൩ = ൥
78.2 2.28 0
2.28 39.4 0

0 0 2.93
൩ 𝑝𝑠𝑖 ∙ 𝑖𝑛ଷ 

We can calculate the bending compliance matrix by inverting the bending stiffness matrix 𝑑௜௝ = 𝐷௜௝
ିଵ.  

൥

𝑑ଵଵ 𝑑ଵଶ 0
𝑑ଵଶ 𝑑ଶଶ 0
0 0 𝑑଺଺

൩ = ൥
1.28 × 10ିଶ −7.40 × 10ିସ 0

−7.40 × 10ିସ 2.54 × 10ିଶ 0
0 0 3.41 × 10ିଵ

൩ (𝑝𝑠𝑖 ∙ 𝑖𝑛ଷ)ିଵ 

Both 𝐷௜௝ and 𝑑௜௝ matrices are compared with the values computed by FEMAP and they were matching quite well. One 
can always verify their hand calculations with the computed values from FEMAP to debug any errors. A snapshot of the 
layup configuration input to FEMAP is shown below.  
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The computed 𝐷௜௝ and 𝑑௜௝ matrices from FEMAP are compared with the hand calculations (shown below). 

 Matrix Terms Hand Calculation FEMAP 

Bending Stiffness Matrix 

𝐷௜௝ 

𝐷ଵଵ 78.2 78.2 

𝐷ଶଶ 39.4 39.4 

𝐷ଵଶ 2.28 2.28 

𝐷଺଺ 2.93 2.94 

Bending Compliance 
Matrix 

𝑑௜௝ 

𝑑ଵଵ 1.28 × 10ିଶ 1.28 × 10ିଶ 

𝑑ଶଶ 2.54 × 10ିଶ 2.54 × 10ିଶ 

𝑑ଵଶ −7.40 × 10ିସ −7.40 × 10ିସ 

𝑑଺଺ 3.41 × 10ିଵ 3.40 × 10ିଵ 

Next, we would like to analyze ply level stresses for the loading configuration shown below. The moment applied here is 
derived from a four-point bending load configuration with a total load of 2 lbf. From the bending moment diagram, the 
moment at half the length of the specimen is 9 lbf-in.The ply level stress evaluation in hand calculation does not account 
for the length of the specimen. However, the moment applied at the end will be used in calculating the stresses.  

 

L=11 in.

M=9 lbf-in.9 in.

1 lbf1 lbf

9 in.4 in.
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In order to calculate the ply level stresses and strains, we need to calculate the curvatures using the moments and 𝑑௜௝. 
From curvatures, we can calculate the strains and then stresses from strains. The moment-curvature relation is shown 
below. Here the moment 𝑀௜  is defined as the moment per unit width.  

൝
𝑀ଵ

𝑀ଶ

𝑀଺

ൡ = ൥

𝐷ଵଵ 𝐷ଵଶ 𝐷ଵ଺

𝐷ଶଵ 𝐷ଶଶ 𝐷ଶ଺

𝐷଺ଵ 𝐷଺ଶ 𝐷଺଺

൩ ൝

𝜅ଵ

𝜅ଶ

𝜅଺

ൡ 

The above relation can be expressed in terms of compliance as shown below ([𝑑௜௝] = [𝐷௜௝]-1) 

൝

𝜅ଵ

𝜅ଶ

𝜅଺

ൡ = ൥

𝑑ଵଵ 𝑑ଵଶ 𝑑ଵ଺

𝑑ଶଵ 𝑑ଶଶ 𝑑ଶ଺

𝑑଺ଵ 𝑑଺ଶ 𝑑଺଺

൩ ൝
𝑀ଵ

𝑀ଶ

𝑀଺

ൡ 

In our example, we have 𝑀ଵ=−𝑀/𝑏, 𝑀ଶ=0 and 𝑀଺=0. 𝑀 is the total moment. We know the moments and we can 
calculate the curvatures as shown below. 

൝

𝜅ଵ

𝜅ଶ

𝜅଺

ൡ = ൥
1.28 × 10ିଶ −7.40 × 10ିସ 0

−7.40 × 10ିସ 2.54 × 10ିଶ 0
0 0 3.41 × 10ିଵ

൩ ൝
−𝑀/𝑏

0
0

ൡ 

The moment is 𝑀 = 9 lbf-in. and the width of the specimen is 𝑏 = 3 in. 

൝

𝜅ଵ

𝜅ଶ

𝜅଺

ൡ = ൥
1.28 × 10ିଶ −7.40 × 10ିସ 0

−7.40 × 10ିସ 2.54 × 10ିଶ 0
0 0 3.41 × 10ିଵ

൩ ൝
−3
0
0

ൡ = ൝
−3.84 × 10ିଶ

2.22 × 10ିଷ

0

ൡ 

We can calculate strains from curvatures. 

൝

𝜀ଵ

𝜀ଶ

𝜀଺

ൡ = 𝑧 ൝

𝜅ଵ

𝜅ଶ

𝜅଺

ൡ 

Here, 𝑧 corresponds to the distance from the midplane of the laminate layup to midplane of a ply. 

For the top most ply (0° ply), 𝑧=0.0175 in. The strains in the 0° ply are shown below. 
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൝

𝜀ଵ

𝜀ଶ

𝜀଺

ൡ = 0.0175 ൝
−3.84 × 10ିଶ

2.22 × 10ିଷ

0

ൡ = ൝
−6.72 × 10ିସ

3.89 × 10ିହ

0

ൡ 

We can calculate stresses in this ply using the following relation. 

൝

𝜎ଵ

𝜎ଶ

𝜎଺

ൡ = ൥

𝑄ଵଵ 𝑄ଵଶ 𝑄ଵ଺

𝑄ଶଵ 𝑄ଶଶ 𝑄ଶ଺

𝑄଺ଵ 𝑄଺ଶ 𝑄଺଺

൩ ൝

𝜀ଵ

𝜀ଶ

𝜀଺

ൡ = ൥
20.7 × 10଺ 4.27 × 10ହ 0
4.27 × 10ହ 1.31 × 10଺ 0

0 0 5.50 × 10ହ

൩ ൝
−6.72 × 10ିସ

3.89 × 10ିହ

0

ൡ 

൝

𝜎ଵ

𝜎ଶ

𝜎଺

ൡ = ൝
−13.9
−0.24

0
ൡ  𝑘𝑠𝑖 

The stresses computed above are for the top ply and we see compressive stresses. Following the above procedure, we 
can calculate the stresses in all the other plies. The displacement for this loading configuration is calculated as shown 
below. 

𝛿 =
𝑀𝐿ଶ

2𝐸𝐼
=

𝑀𝐿ଶ

2𝑏
𝑑ଵଵ 

From hand calculations, the displacement was 2.3 in. 
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Table 6 provides the ply level stresses from hand calculations.  

Table 6: Ply level stresses computed from the classical lamination theory for a [0/90/0/90]s layup 

Ply Stresses (ksi) Hand Calculation 

Ply 1 
𝜎ଵ 13.9 

𝜎ଶ 0.24 

Ply 2 
𝜎ଵ 0.62 

𝜎ଶ -0.37 

Ply 3 
𝜎ଵ 5.97 

𝜎ଶ 0.10 

Ply 4 
𝜎ଵ 0.12 

𝜎ଶ -0.07 
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 SANDWICH COMPOSITE  

In the previous section, all the required basics are discussed for analyzing the flexural behavior of sandwich composite. 
Here, we are adding a core and separating the laminated facesheets. We will show the hand calculations for a sandwich 
composite with layup configuration [0/90/0/90/Core/90/0/90/0]. The stiffness matrices (𝑄௜௝ i, j = 1, 2, 6) will remain the 
same as we are using the same orientations (calculated in the previous section for a [0/90/0/90]S layup). Since the 
stacking sequence now includes a core, we have to account the core thickness (facesheet separation) in the bending 
stiffness matrix (𝐷௜௝) calculation.  

When we have a core in the layup, it is treated as an equivalent number of plies. Accordingly, the limits on the 
summation in the bending stiffness matrix [𝐷௜௝] are modified as shown below.  

𝐷௜௝ =
2

3
𝑡௣௟௬

ଷ ෍ 𝑄௜௝
௞[𝑘ଷ − (𝑘 − 1)ଷ]

௡
ଶൗ

௞ୀ
௡೎

ଶൗ ାଵ

 

Here, 𝑛 is the total number of equivalent plies in the sandwich composite and 𝑛௖ is the number of equivalent plies in a 
core. In our example, we have a total thickness of 1 in. for the sandwich composite and 0.96 in. for the core. We have an 
individual ply thickness 𝑡௣௟௬ = 0.005 in. So, 𝑛=1/0.005=200 and 𝑛௖=0.96/0.005=192. In the above equation, 𝑘 is the ply 
number and ranges from 97 to 100. We can also see that the bending stiffness matrix accounts for the stiffness of the 
facesheet only. 

Substituting 𝑄௜௝ of 0° and 90° plies from the previous section, we get, 

൥

𝐷ଵଵ 𝐷ଵଶ 0
𝐷ଵଶ 𝐷ଶଶ 0

0 0 𝐷଺଺

൩ = ൥
1.07 × 10ହ 4.10 × 10ଷ 0
4.10 × 10ଷ 1.05 × 10ହ 0

0 0 5.28 × 10ଷ

൩ 𝑝𝑠𝑖 ∙ 𝑖𝑛ଷ 

 

 

 

 



 

 

Predictive Engineering White Paper 

 
2020 

Predictive Engineering Document, Feel Free to Share With Your Colleagues Page 72 of 107 

We can calculate the bending compliance matrix by inverting the bending stiffness matrix 𝑑௜௝ = 𝐷௜௝
ିଵ.  

൥

𝑑ଵଵ 𝑑ଵଶ 0
𝑑ଵଶ 𝑑ଶଶ 0
0 0 𝑑଺଺

൩ = ൥
9.37 × 10ି଺ −3.66 × 10ି଻ 0

−3.66 × 10ି଻ 9.54 × 10ି଺ 0
0 0 1.89 × 10ିସ

൩ (𝑝𝑠𝑖 ∙ 𝑖𝑛ଷ)ିଵ 

Similar to the previous section, we would like to verify the hand calculations with the FEMAP computed values. The layup 
configuration input to FEMAP is shown below.  

 
 

 

 

 



 

 

Predictive Engineering White Paper 

 
2020 

Predictive Engineering Document, Feel Free to Share With Your Colleagues Page 73 of 107 

The computed 𝐷௜௝ and 𝑑௜௝ matrices from FEMAP are compared with the hand calculations (shown below). 

 Matrix Terms Hand Calculation FEMAP 

Bending Stiffness Matrix 

𝐷௜௝ 

𝐷ଵଵ 1.07 × 10ହ 1.07 × 10ହ 

𝐷ଶଶ 1.05 × 10ହ 1.05 × 10ହ 

𝐷ଵଶ 4.10 × 10ଷ 4.10 × 10ଷ 

𝐷଺଺ 5.28 × 10ଷ 5.30 × 10ଷ 

Bending Compliance 
Matrix 

𝑑௜௝ 

𝑑ଵଵ 9.37 × 10ି଺ 9.37 × 10ି଺ 

𝑑ଶଶ 9.54 × 10ି଺ 9.54 × 10ି଺ 

𝑑ଵଶ −3.66 × 10ି଻ −3.66 × 10ି଻ 

𝑑଺଺ 1.89 × 10ିସ 1.89 × 10ିସ 

Next, we would like to analyze ply level stresses for the loading configuration shown below. The moment applied here is 
derived from a four-point bending load configuration with a total load of 900.9 lbf. From the bending moment diagram, 
the moment at half the length of the specimen is 4054 lbf-in. 

 
 

L=11 in.

M=4054.05 lbf-in.9 in.

450.45 lbf450.45 lbf

9 in.4 in.
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The moment-curvature relation is shown below. Here the moment 𝑀௜  is defined as the moment per unit width.  

൝
𝑀ଵ

𝑀ଶ

𝑀଺

ൡ = ൥

𝐷ଵଵ 𝐷ଵଶ 𝐷ଵ଺

𝐷ଶଵ 𝐷ଶଶ 𝐷ଶ଺

𝐷଺ଵ 𝐷଺ଶ 𝐷଺଺

൩ ൝

𝜅ଵ

𝜅ଶ

𝜅଺

ൡ 

The above relation can be expressed in terms of compliance as shown below ([𝑑௜௝] = [𝐷௜௝]-1) 

൝

𝜅ଵ

𝜅ଶ

𝜅଺

ൡ = ൥

𝑑ଵଵ 𝑑ଵଶ 𝑑ଵ଺

𝑑ଶଵ 𝑑ଶଶ 𝑑ଶ଺

𝑑଺ଵ 𝑑଺ଶ 𝑑଺଺

൩ ൝
𝑀ଵ

𝑀ଶ

𝑀଺

ൡ 

In our example, we have 𝑀ଵ=−𝑀/𝑏, 𝑀ଶ=0 and 𝑀଺=0. 𝑀 is the total moment. We know the moments and we can 
calculate the curvatures as shown below. 

൝

𝜅ଵ

𝜅ଶ

𝜅଺

ൡ = ൥
9.37 × 10ି଺ −3.66 × 10ି଻ 0

−3.66 × 10ି଻ 9.54 × 10ି଺ 0
0 0 1.89 × 10ିସ

൩ ൝
−𝑀/𝑏

0
0

ൡ 

The moment is 𝑀 = 4054 lbf-in. and the width of the specimen is 𝑏 = 3 in. 

൝

𝜅ଵ

𝜅ଶ

𝜅଺

ൡ = ൥
9.37 × 10ି଺ −3.66 × 10ି଻ 0

−3.66 × 10ି଻ 9.54 × 10ି଺ 0
0 0 1.89 × 10ିସ

൩ ൝
−1351.35

0
0

ൡ = ൝
−1.27 × 10ିଶ

4.95 × 10ିସ

0

ൡ 

We can calculate strains from curvatures. 

൝

𝜀ଵ

𝜀ଶ

𝜀଺

ൡ = 𝑧 ൝

𝜅ଵ

𝜅ଶ

𝜅଺

ൡ 

Here, 𝑧 corresponds to the distance from the midplane of the sandwich composite to midplane of the corresponding ply 
layer. 
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For the top most ply (0° ply), 𝑧=0.4975 in. The strains in the 0° ply are shown below. 

൝

𝜀ଵ

𝜀ଶ

𝜀଺

ൡ = 0.4975 ൝
−1.27 × 10ିଶ

4.95 × 10ିସ

0

ൡ = ൝
−6.30 × 10ିଷ

2.46 × 10ିସ

0

ൡ 

We can calculate stresses in this ply using the following relation. 

൝

𝜎ଵ

𝜎ଶ

𝜎଺

ൡ = ൥

𝑄ଵଵ 𝑄ଵଶ 𝑄ଵ଺

𝑄ଶଵ 𝑄ଶଶ 𝑄ଶ଺

𝑄଺ଵ 𝑄଺ଶ 𝑄଺଺

൩ ൝

𝜀ଵ

𝜀ଶ

𝜀଺

ൡ = ൥
20.7 × 10଺ 4.27 × 10ହ 0
4.27 × 10ହ 1.31 × 10଺ 0

0 0 5.50 × 10ହ

൩ ൝
−6.30 × 10ିଷ

2.46 × 10ିସ

0

ൡ 

൝

𝜎ଵ

𝜎ଶ

𝜎଺

ൡ = ൝
−131
−2.37

0
ൡ  𝑘𝑠𝑖 

Since it is the top most ply, the stresses are compressive. Similarly, we can calculate the stresses in other plies by 
changing the distance 𝑧 and also accounting for off-axis to on-axis transformation.  
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Table 7 provides the ply level stresses from hand calculations.  

Table 7: Ply level stresses computed from the classical lamination theory for a [0/90/0/90/Core/90/0/90/0] layup 

Ply Stresses (ksi) Hand Calculation 

Ply 1 
𝜎ଵ 131 

𝜎ଶ 2.37 

Ply 2 
𝜎ଵ 8.06 

𝜎ଶ -2.39 

Ply 3 
𝜎ଵ 128 

𝜎ଶ 2.32 

Ply 4 
𝜎ଵ 7.90 

𝜎ଶ -2.34 

 

For the four-point bending problem, the deflection 𝛿 =
௉ቀ

ೄషಽ

మ
ቁ(ଷௌమି(ௌି௅)మ)

ସ଼ாூ
. Here, 𝐸𝐼 can be expressed as ௕

ௗభభ
 (refer to the 

textbook) 

𝛿 =
𝑃 ቀ

𝑆 − 𝐿
2 ቁ (3𝑆ଶ − (𝑆 − 𝐿)ଶ)

48𝑏
𝑑ଵଵ = 0.6 𝑖𝑛. 
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11.2 FINITE ELEMENT SIMULATION 

A half-symmetric model of the four-point bending specimen was used in the finite element simulation. It is important to 
note this half symmetry approach will not be applicable when we have ply orientation angles other than 0° and 90°. The 
sandwich composite is modeled using laminate plate elements (procedure discussed in section 6.6 – method 1). The 
screen shots of the material properties used for the facesheet and the core are provided below. Imperial unit system was 
used for this example. The classical lamination theory assumes the laminated plate is non-shear deformable. Accordingly, 
the transverse shear moduli of the core are set to a high value. 
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A screen shot of the layup configuration used in the finite element model is shown below. 

 
The boundary conditions used in the finite element model are shown below. 
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The required load (P/2=450.45 lbf) was applied on the nodes using a combination of GAP elements and RBE2s as shown 
below. This procedure allows for a better distribution of loads on the nodes. A new set of nodes have been created by 
duplicating and offsetting the nodes along the loading region by a finite distance (here 0.1 in.). These new set of nodes 
are connected to the corresponding nodes on the loading region using GAP elements. The GAP element properties (i.e., 
compression stiffness is adjusted in an increasing fashion until there is a minimal change (~0.01%) in the forces 
distributed on the nodes. A snapshot of the GAP element properties is shown below.  
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The load application procedure is illustrated below. The freebody diagram shows the nodal force distribution. One can 
manually calculate the force at each node (accounting for difference in the contribution of force at end nodes and mid 
nodes) and compare them with the values obtained using the GAP elements. The latter procedure will give a more 
gradual distribution of forces as compared to the former case. A nonlinear static analysis is used in this case (with GAP 
elements). This procedure is used as an initial step to get the load distribution at each node. GAP elements are nonlinear 
elements and will involve stiffness updates during the analysis depending on the GAP status (i.e., open or closed). These 
GAP stiffness updates will modify the global stiffness matrix.  
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In this example GAP elements are used only to get the load distribution on the nodes. A linear static analysis is performed 
with the nodal forces obtained from a nonlinear static analysis. In this case, no GAP elements are used and the forces are 
directly applied on the nodes. 

From the finite element simulation, the maximum displacement in the sandwich composite under four-point bending is 
0.6 in.   

 
 

 

 

 

 

 



 

 

Predictive Engineering White Paper 

 
2020 

Predictive Engineering Document, Feel Free to Share With Your Colleagues Page 82 of 107 

The maximum tensile stress in the bottom ply (0° - ply 1) is 131 ksi.  

 
 

An important note on post processing the simulation results for off-axis plies (other than 0° - for example 90°, 45° etc.) is 
that NX Nastran prints out stresses in the fiber and material directions and not the element coordinate system (as with 
an isotropic material). We can check this by printing the stresses in the .fo6 file.  
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A snapshot of the stresses printed in the .fo6 file is shown below. 

 
Notice that Normal-1 and Normal-2 convention is used unlike Normal-X and Normal-Y. However, while post processing 
FEMAP uses these stresses and stores them in the output vector – Lam Ply X Normal Stress and Lam Ply Y Normal Stress. 
Although FEMAP calls it X Normal Stress and Y Normal Stress, they correspond to Normal-1 and Normal-2 respectively. 
This implies that Lam Ply X Normal Stress is in the ply fiber direction and Lam Ply Y Normal Stress is in the ply matrix 
direction (transverse direction). If one is comparing with the hand calculations, these stresses have to be transformed as 
hand calculations correspond to global X- and Y- directions (or 0° angle for the entire laminate as specified in the 
property card). In this example the material angle (specified on element property card) is in the global X-direction (shown 
below).  
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Since ply 1 is 0° (in this example), no transformation is required. Ply 2 is 90° and requires transformation. Accordingly, the 
stresses can be transformed to global –X and –Y as shown below. These transformations have to be used carefully as they 
would significantly change the results.  Another option is to transform the stresses in the hand calculations to the ply 
orientation angle (no transformation in FEMAP is required in that case).  
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11.3 SUMMARY OF RESULTS 

From the four-point bending experimental testing, the maximum deflection for the applied load was 0.85 in. From the 
finite element simulation and hand calculations, the calculated displacements for the [0/90/0/90/Core/90/0/90/0] layup 
were 0.6 in. each. It should be noted that the thickness of each ply used in hand calculations and finite element 
simulation was 0.005 in. Accordingly, the sandwich into an equivalent number of plies giving a round number for the 
hand calculation. If an actual thickness from the experiment was used, a deflection within 10% difference from the 
experimental value could be obtained.   

The stresses calculated using the finite element simulation and hand calculations are shown below. The finite element 
simulation was repeated for [0/45/0/-45/Core/-45/0/45/0] using a full model (no symmetry due to 45° plies) and the 
stresses are compared with hand calculations. It should be noted that the classical lamination theory does not account 
for ply level stress distribution in the specimen width direction. When a [0/90/0/90/Core/90/0/90/0] was used, the 
stresses are uniform in the width direction. However, for a [0/45/0/-45/Core/-45/0/45/0] layup, the stresses vary in the 
width direction due to the off-axis plies. As a result, the simulated stresses deviate from the hand calculations when 
actual specimen widths are used in the finite element model. To reduce this effect, an infinitesimally thin width specimen 
has to be modeled when off-axis plies are used such that the model conforms to the classical lamination theory 
assumptions and so does the ply level stresses.  
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Table 8 provides the comparison of the ply level stresses computed using hand calculations and finite element 
simulations. 

Table 8: Comparison of ply level stresses between hand calculations and FEA results 

Ply 

0/90/0/90/Core/90/0/90/0 0/45/0/-45/Core/-45/0/45/0 
Finite 

Element 
Analysis 

Hand 
Calculation 

Difference 
(%) 

Finite 
Element 

Analysis** 

Hand 
Calculation 

Difference 
(%) 

Ply 1 
𝜎ଵ (ksi) 131 131 0 124 124 0 

𝜎ଶ (ksi) 2.37 2.38 0.4 -3.26 -3.26 0 

Ply 2 
𝜎ଵ (ksi) -2.39 -2.40* 0.4 16.5 16.5* 0 

𝜎ଶ (ksi) 8.06 8.10* 0.5 1.38 1.39* 0.7 

Ply 3 
𝜎ଵ (ksi) 128 129 0.8 121 121 0 

𝜎ଶ (ksi) 2.32 2.33 0.4 -3.20 -3.20 0 

Ply 4 
𝜎ଵ (ksi) -2.34 -2.36* 0.8 16.6 16.7* 0.6 

𝜎ଶ (ksi) 7.90 7.94* 0.5 1.34 1.33* 0.7 

*Transformed stresses in to fiber and matrix directions to be consistent with FEMAP output vectors 
**FEA results for this layup are based on a laminate with thin width (0.1 in.)  

 

Note: ASTM Standard D7249 is often used for evaluating the flexural behavior of sandwich composites. This standard 
provides equations for calculating the stresses in the facesheet corresponding to a maximum load. However, it should be 
noted that the standard is not ideal for calculating stresses in the facesheet with different ply orientations. Rather, the 
standard is applicable for facesheets with unidirectional ply orientation and homogeneous facesheets (e.g. aluminum).   
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12. ADDENDUM 

In this section, the examples presented in the white paper with the NX Nastran Solver are replicated using the LS-DYNA 
solver. FEMAP is the preprocessor however some modifications were done in LS-PrePost for TSHELL (LS-DYNA’s layered 
solid) elements. The following is the summary of results using the LS-DYNA solver. A brief comparison of the results was 
also presented to understand the applicability of both the solvers. 

12.1 EXAMPLE 1 (2D LAMINATE WITH A HOLE) 

 DISPLACEMENT CONTOUR 

 
LS-DYNA NX NASTRAN 

Remark: Displacement plots match quite well 
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 MAJOR PRINCIPAL STRESS IN PLY 4 (0°) 

 

LS-DYNA NX NASTRAN 

Remark: Major Principal Stress plots match well. In order to analyze ply level stresses, the number of integration points 
(plies) in the laminate has to be entered in DATABASE_EXTENT_BINARY (MAXINT=8 for this example).  

 

 

 

 



 

 

Predictive Engineering White Paper 

 
2020 

Predictive Engineering Document, Feel Free to Share With Your Colleagues Page 89 of 107 

 UNSYMMETRIC LAMINATE 

 

LS-DYNA NX NASTRAN 

Remark: The out-of-plane deformations observed from both the solvers are similar. Although this example uses shell 
elements, when modeling an unsymmetric laminate in LS-DYNA, the moduli and Poisson’s ratio in direction-3 (out-of-
plane) should also be entered. Otherwise, erroneous results can be encountered. The reasoning behind the out-of-plane 
deformations observed in an unsymmetric laminate despite the uniaxial load is detailed in the Appendix. 
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12.2 EXAMPLE 2 (3D LAMINATE WITH A HOLE) 

 DISPLACEMENT CONTOUR 

 

LS-DYNA NX NASTRAN 

Remark: Displacement plots match quite well 
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 MAJOR PRINCIPAL STRESS IN PLY 4 (0°) 

 

LS-DYNA NX NASTRAN 

Remark: The contour of the major principal stress for ply 4 looks similar between LS-DYNA and NX Nastran. However, the 
results deviate (max result varies by ~19%). The LS-DYNA result with TSHELL (thick shell) was observed to be similar to 
shell formulation (example 1).  

 

 

 

 



 

 

Predictive Engineering White Paper 

 
2020 

Predictive Engineering Document, Feel Free to Share With Your Colleagues Page 92 of 107 

 3D SOLID LAMINATE WITH ONE ELEMENT FOR EACH LAYER THROUGH THICKNESS 

 
Remark: Here, one solid element for each ply is explicitly defined as shown above. This is a computationally expensive 
procedure which is particularly significant when modeling composite laminates with several layers (e.g., >50). This led to 
the development of a TSHELL element (discussed previously) using which all the plies could be defined in a single 
element layer through the laminate thickness.  
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LS-DYNA NX NASTRAN 

Remark: For this example, the displacement and stress plots are similar between the regular solid element and NX 
Nastran’s Laminate Solid element.  

 

Displacement 
contour 

Major Principal 
Stress in Ply 4 (0°) 
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12.3 EXAMPLE 3 (3D SANDWICH COMPOSITE) 

 DISPLACEMENT CONTOUR 

 

LS-DYNA NX NASTRAN 

Remark: Displacement plots match well 
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 TRANSVERSE SHEAR STRESS (ZX) IN CORE 

 

LS-DYNA NX NASTRAN 

Remark: The transverse shear stress plots on the core look similar however they vary by ~10%. 
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12.4 EXAMPLE 4 (2D LAMINATE WITH FAILURE) 

 LAMINATE FAILURE 

 
LS-DYNA NX NASTRAN 

Remark: The failure region predicted by both the solvers is similar. In LS-DYNA a flag=1 implies no failure and flag=0 
implies complete failure. We see that in the regions other than red, failure has initiated in some plies. The minimal value 
is not zero implying that the element did not fail completely. This means that in some plies, for the same element, failure 
did not occur. For ply level failures, LS-DYNA can explicitly specify the mode of failure whereas in NX Nastran we saw that 
it only indicates if a ply has failed or not (but not the failure mode). In order to analyze ply level failures (failure modes), 
additional history variables need to be requested in addition to specifying the total number of integration points. The 
NEIPS parameter in DATABASE_EXTENT_BINARY is set to 6 for this example. The output vector corresponding to each of 
these history variables is listed in the LS-DYNA manuals. For this example, we have used MAT_54 as our material model. 
History variable 5 (for MAT_54) gives the laminate failure index. 
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 FAILURE IN LONGITUDINAL TENSION 

 
Remark: Ply 4 and Ply 5 (0°) have partially failed in longitudinal tension. This is output using history variable 1. 

None of the plies have failed in longitudinal compression (history variable 2). 
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 FAILURE IN TRANSVERSE TENSION 

 
Remark: Plies 1, 8 (45°) and Plies 3, 6 (-45°) have partially failed in transverse tension. This is output using history variable 
3. 

None of the plies have failed in transverse compression (history variable 4). 
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13. APPENDIX 

13.1 CLASSICAL LAMINATION THEORY 

The classical lamination theory (CLT) is similar to the classical plate theory (CPT), the only difference is that CPT assumes 
that the material is isotropic, while the CLT is an extension to fiber-reinforced composite laminates with multiple layers 
resulting in complicated stress-strain relations [6]. Similar to the Euler-Bernoulli beam theory and the plate theory, the 
CLT is only valid for thin laminates (span and width > 10×thinckness) with small displacements in the transverse direction. 

The four cornerstones of the CLT are the kinematic, constitutive, force resultant, and equilibrium equations.  

 KINEMATIC EQUATIONS 

 
Here, u0, v0, and w0 are the displacements of the middle plane in the x, y, and z directions. Similarly, εx

0, εy
0, and γxy

0 are 
the mid-plane strains, and ĸx, ĸy, and ĸxy are the curvatures.  

 CONSTITUTIVE EQUATIONS 

 
where the subscript k indicates the kth layer counting from the top of the laminate. 
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 RESULTANTS 

 

 
The terms on the left hand side are force and moment resultants. 

 EQUILIBRIUM EQUATIONS 

 
 STIFFNESS MATRICES A, B, AND D 

The relations between the resultants (forces N and moments M) and the strains (strains ε and curvatures ĸ) are of 
interest in composite laminates. By replacing the stresses in the force and moment resultants with strains via the 
constitutive equations, we have 
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By applying the summation and integration operations to their respective components, the force and moment resultants 
can be expressed as, 

 

The above equations can be expressed as, 

 
where A is called the extensional stiffness, B is called the coupling stiffness, and D is called the bending stiffness of the 
laminate. The components of these three stiffness matrices are defined as follows: 
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Here tk is the thickness of the kth layer and is the distance from the mid-plane to the centroid of the kth layer. 

13.2 UNSYMMETRIC LAYUP  

From the classical lamination theory, we have the following relation between force/moment resultants, and the strains 
and curvatures. 

 
For example consider only the axial force component 𝑁௫. We have, 

𝑁௫ = 𝐴ଵଵ𝜀௫
଴ + 𝐴ଵଶ𝜀௬

଴ + 𝐴ଵ଺𝛾௫௬
଴ + 𝐵ଵଵ𝜅௫ + 𝐵ଵଶ𝜅௬ + 2𝐵ଵ଺𝜅௫௬ 

For an isotropic material, we have only 𝐴ଵଵ and 𝐴ଵଶ. The remaining components 𝐴ଵ଺, 𝐵ଵଵ, 𝐵ଵଶ, and 𝐵ଵ଺ are all zero. Thus, 
the axial force component in an isotropic material is related to inplane strains only. However, for composite laminates, 
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the components 𝐴ଵ଺, 𝐵ଵଵ, 𝐵ଵଶ, and 𝐵ଵ଺ can exist and will influence the deformation behavior. The ‘compute’ option in 
layup editor can be handy in checking these components.  

For the symmetric laminate in Example 1, the following information is obtained when the ‘compute’ option is selected. 
We can see that all the components in the B matrix (coupling stiffness matrix) are zero. Thus, we do not see any out-of-
plane deformation in the symmetric laminate case. 

A Matrix 
9.48215E+7   3.01204E+7   0.00000E+0 
3.01204E+7   9.48215E+7   0.00000E+0 
0.00000E+0   0.00000E+0   3.23506E+7 

 
B Matrix 

0.00000E+0   0.00000E+0   0.00000E+0 
0.00000E+0   0.00000E+0   0.00000E+0 
0.00000E+0   0.00000E+0   0.00000E+0 

 
D Matrix 

1.09875E+1   8.07952E+0   5.17406E+0 
8.07952E+0   2.34052E+1   5.17406E+0 
5.17406E+0   5.17406E+0   8.53069E+0 

Similarly, for the unsymmetric laminate, 
A Matrix 

9.48215E+7   3.01204E+7   0.00000E+0 
3.01204E+7   9.48215E+7   0.00000E+0 
0.00000E+0   0.00000E+0   3.23506E+7 

 
B Matrix 

-1.3176E+4   2.54946E+3   5.31327E+3 
2.54946E+3   8.07707E+3   5.31327E+3 
5.31327E+3   5.31327E+3   2.54946E+3 

 
D Matrix 

2.12521E+1   6.09339E+0   1.03481E+0 
6.09339E+0   1.71129E+1   1.03481E+0 
1.03481E+0   1.03481E+0   6.54455E+0 

Now, we see that the B matrix has finite values and as a result, we see out-of-plane deformation in the unsymmetric 
laminate case. This information is quite useful in designing unsymmetric laminates, by tailoring the layup orientation 
angles to retain required matrix components (ABD matrices) only. 
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13.3 CHAMIS MODEL 

 
13.4 ONSET FAILURE THEORY 

The onset theory [7-9] assumes that the critical effective properties of the lamina that control damage initiation are the 
effective volumetric and equivalent strains of the lamina. Both the volumetric strain and the equivalent strain of the 
lamina are defined using strain invariants. The volumetric strain (critical dilatational strain invariant) is defined by the 
first invariant of the strain and the equivalent strain (critical distortional strain invariant) is a function of the second 
invariant of the strain. The strain invariants are functions of three principal strains. The volumetric strain is given by, 

 

𝑉𝑜𝑙𝑢𝑚𝑒𝑡𝑟𝑖𝑐 𝑠𝑡𝑟𝑎𝑖𝑛 = 𝐽ଵ + 𝐽ଶ + 𝐽ଷ                                                                                          (1) 

Where, 

𝐽ଵ = 𝜀ଵ + 𝜀ଶ + 𝜀ଷ 

𝐽ଶ = 𝜀ଵ𝜀ଶ + 𝜀ଵ𝜀ଷ + 𝜀ଶ𝜀ଷ 

𝐽ଷ = 𝜀ଵ𝜀ଶ𝜀ଷ 
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ε1, ε2, and ε3 are the three principal strains 

J1, J2, and J3 are the invariants of the strain tensor 

 

The significant component of the volumetric strain is the first invariant of strain tensor. The reduced form of volumetric 
strain is given by, 

𝑉𝑜𝑙𝑢𝑚𝑒𝑡𝑟𝑖𝑐 𝑠𝑡𝑟𝑎𝑖𝑛 = 𝐽ଵ =  𝜀ଵ + 𝜀ଶ + 𝜀ଷ                                                                                  (2) 

The equivalent strain (distortional strain invariant, change in shape) is given by, 

𝜀௘௤௩ = ඨ
(𝜀ଵ − 𝜀ଶ)ଶ + (𝜀ଶ − 𝜀ଷ)ଶ + (𝜀ଵ − 𝜀ଷ)ଶ

2
                                                                              (3) 

For details on the implementation of the onset theory, it is recommended to read the references [7-9]. 
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Equivalent laminate models are useful when only displacements, buckling loads and modes, or vibration frequencies and 
modes are required (Barbero book).  

 


